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e-Ledger – ADMINISTRATIVE/IMPLEMENTING DEPARTMENT USER MANUAL 
 

The user manual shown below has to be followed for an understanding on the usual procedures to 

be followed by the Administrative Department for generating the draft Government Order releasing the 

fund placed under e-Ledger through online. 

 

� Each Administrative Department is given two sets of user IDs and Passwords irrespective of 

number of sections there. 

� The first user is a lower level user who drafts the Government Order for releasing the amount 

placed in the e-Ledger. 

� The second user is a higher level officer who approves the draft prepared at lower levels and after 

getting vetted from Finance Department. 

 

e.g., : if XYZ is lower level user then his password will be XYZ@123 

 And XYZadmin is the user ID for the higher level user and XYZadmin@123 is the password for 

that user. 
 

How to Login 

The screen shot below shows the link to the e-Ledger site. It can be accessed through the FD’s 

website ‘finance.kerala.gov.in and the link provided there in as: 

 

 

 

Or 

 

in the address bar of the web browser, type ‘treasury.kerala.gov.in/eledger/’ without quotes. 

 

 

 

 

 

 

 

 

 

Click this link. 
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 The login screen will be like this : 
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 The successful login for the lower level user (draft GO generation) will look like this : 

 

 

 The releases menu shows GO releases and GO to treasury. GO to treasury is required when a 

government release itself is sufficient for drawl of money from treasury without further proceedings from 

the implementing department.  In such situation, the concerned Administrative Department has to send 

the GO to the concerned treasury after selecting the drop down list of treasuries listed there (explained 

later). 
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 The report menu shows the GO proceedings from the lower levels. 
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Preparation of Draft GO releasing fund posted in e-Ledger 

 

 Click the Releases menu – select GO Releases 

 The screen will look as one above. Click the submit button. It will lead to the following page listing 

the various e-Ledger registration under that particular department (see below). 
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 The e-Ledger registration list shows all the registration from the entire sections of that department. 

Select the registration number which has been communicated from FD by the respective sections and click 

the button ‘Go’ to start the drafting process. 

Draft GO generation 

 In almost all cases the draft GO is automatically generated based on the details entered in the 

respective fields. If there is no Administrative Sanction, the GO should be generated manually. 

 Before starting the draft preparation, the user has to do the following tasks: 

� The letter from the implementing department/ agency requesting to release e-Ledger amount has 

to be scanned and stored in the system in a convenient location for further upload when asked by 

the system. 

� The copy of the Administrative Sanction for the proposed scheme has to be scanned and stored in 

the system in a convenient location for further upload when asked by the system. 

� In case, if there is no AS for the scheme or the scheme is continuing one for a longer period and no 

copy of the AS is available, in such case the GO drafting to be in a manual mode i.e., a blank page 

in the GO format will be available to the user for direct entry of all wordings of the GO in the page. 

In such cases if manual GO to be set, contact e-Ledger administrator at once. 

 

 

Select the required 

register number 

Click the ‘Go’ 

Button 
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 When the user click the ‘Go’ button as shown above, a page will display as shown below : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the Add tab button to start a new draft GO. Click the View tab button to 

view already created GO. Click the Edit tab button to edit further modification in 

the GO after it has been drafted but before sending to higher levels and also for 

putting the Original GO number when the draft has been vetted by the FD. 
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 The screen shot below shows the result of clicking ‘Add’ and also there is Administrative Sanction 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the release amount now 

required in the box in lakh.  

Verify the department name 

appeared there is correct and 

select the concerned section 

from the drop down. 

Enter the implementing 

department/Agency letter 

number and date in the date box. 

Click Yes for AS is available and 

answer the next query there. 

Remarks (if any) to be entered 

below and any comments of the 

AD to FD (not forming part of the 

GO) to be entered. 

After giving the information 

above, click the button ‘Save’ 
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 After the save button is clicked, the file upload section as shown below will appear at the bottom. 

Browse the file already scanned earlier for the AS and letter one after another and click upload. It will show 

the progress of upload there. 
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 After the upload is complete, now click the button ‘Click Here’ in the link shown above. Which will 

show the default GO generated as shown below : 
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 The user can add the following : 

� Any extra reference in the read portion in the space provided there (without serial number) 

� Additional content that can be inserted in the generated window itself in the space marked as 

Extra conditions 1, 2 and 3. Click the question mark on the right of the boxes to know how line 

breaking, bold, italics and under lines are inserted in the conditions. 
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� If additional sending address to be added, insert it in the blank space and click ‘Add More’ next to 

it for further additions in the sending list. 

� If everything has been entered click the buttons ‘Save’ and ‘Close’ below the draft GO. 

 In cases where no Administrative Sanction is there and GO generation has been set manually, the 

click here will bring a window as shown below for direct entry of all wording in the GO. 

 

 Enter the details in the blank space and click close to exit the page when it is over. 

 After exit, now click save once again to save all the text entered above. The user can edit the content 

before it is passed on to the higher officer by selecting the e-Ledger registration number in the ‘Edit’ 

module and clicking the edit icon there. 
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Verifying the Draft and sending to FD for vetting the GO. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

The Officer verifying the draft GO can 

verify the Administrative Sanction, Letter 

from the implementing department and 

the draft GO now generated. The pop up 

of each will display the respective pdf 

files. 
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 Click the approve button on the far right side. This will pop a window as shown below : 

 

If everything is correct and if any information to be conveyed to FD, enter the details in the respective area 

and put a tick mark in the box placed before ‘Forward to Finance Department’ and click ‘Save’. The draft 

will now automatically send to the concerned wing in the Finance department. The AD need not sent the 

concerned e-file or physical file to FD for further processing. 

 

 

 

 

 

 

 

 

 

 

 

Enter communication if 

any 

Put a tick mark here and 

click save 
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Original GO generation 

Once the draft has been verified and got vetted from the FD, the officer who forwarded it has to finally 

approve the draft GO, only then the place will open where G.O number and data has to be entered (in the 

edit mode). 

 

  

 

 

 

 

 

 

 

 

 

 

The blue arrow mark shows 

the draft GO has been sent 

to FD for vetting. 

Once the draft has been received back, this 

symbol will appear and clicking on this will 

pop up the message from FD. And the draft 

is vetted. 

This symbol shows the file 

returned from FD without 

vetting and further 

clarification/modification 

required. By clicking on 

this, a popup message will 

appear to detail about the 

modification. 
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Click the approve button on the right side to finally enable the GO numbering. The screen will show like 

this : 

 

 

 

 

 

 

 

 

 

 

 

 

 

This shows, at whose level, the GO has been 

vetted. Put tick mark and click ‘Approve’. And 

click ‘Save’ button. 
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Before going to make the draft to fair GO, the officer level user has to go to the following module and click 

‘Master – Edit Profile’ section where the name and designation of the officer in-charge of the section to be 

updated as shown below : 
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 If the name of the required officer is not available in the list, now click ‘Add’ button. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

Select Section Name, Name of the Officer, whose 

name should appear in the original GO and 

Designation. In the forward designation, type – Section 

Officer and finally click Save. 
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 This time when the approval has been given the place where GO number to be inserted is now 

opened. For this go to the ‘Releases -- GO Releases’ menu once again. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click here to 

enter the GO 

No & Date. 
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 The section concerned should first take the original GO number either from e-office or manually from 

the GO register maintained in their department. Now click the edit icon on the right side : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the GO number [without G.O. (Rt)], Date of 

GO in the next field and Select Officer Name and 

click ‘Update’. ‘Click Here’ to view the original GO. 
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 The original GO will now visible with the GO number and date of GO as shown below : 
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Sending G.O. to Treasury 

If the Administrative Department itself release fund direct to the implementing department / Agency 

without a proceeding to be issued from the department, one more step has to be followed; Go to the 

‘Releases’ menu – from the dropdown list select ‘GO to Treasury’. 

 

 

 

 

 

 

 

 

 

 

 

 



e-Ledger                                                                                                                                              User Manual                                                             

 

 

     
23232323| Finance Department, Government of Kerala 

    

        

 From the list appeared, select the particular e-Ledger Registration Number and click ‘Go’ on right 

side. A popup window will be displayed as shown below : 

 

 On the other hand if the Implementing Department has to generate proceedings based on the GO 

now released, the action of the Administrative Department will end on making the draft GO as original as 

described earlier. 

Proceeding Generation at Implementing Department level 

 In order to prepare draft proceedings through e-Ledger, the Administrative Department has to 

collect the following details from the respective line departments as : 

� Name of the Officer taking the Draft Proceedings, Designation, his Mobile Number, e-mail ID. 

� Name of the Officer Approving the Draft Proceedings, Designation, his Mobile Number, e-mail ID. 

 After collecting the above information, the Administrative Department user with ‘admin’ privilage 

has to enter the details in the module shown below. Click the Master menu and select ‘Implementing 

Department/Agency User’. 

Click ‘Yes’ radio button and select the concerned 

treasury from the dropdown list and enter the 

DDO Code and click Send button. Now the e-

Ledger Bills should be submitted through 'BIMS' 

application by Selecting Bill Type as e-LAMS Bills. 

Henceforth only this DDO can prepare the Bills. 
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 If the Name of Officers is already entered those will be displayed there. Otherwise Click the ‘Add’ 

button next to ‘View’ menu which displays as : 

 

 Enter the details in the box first for the Draft user and then for the Approval after selecting the user 

type. click ‘Save’. Again in come to the ‘View’ mode and select the Department Name to view the details 

will be available there as shown below : 
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For the Draft User, put tick mark before the 

SMS box and click PIN and wait for the 

message. This will show a 4 digit pin number 

which will then available to the Draft User. 

Once this message is received, now select the 

approval user and follow the procedure. 
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The Implementing Department’s Username and Password will be their respective mobile number and the 

PIN generated against their mobile number. They can login to the site from : 

 



e-Ledger                                                                                                                                              User Manual                                                             

 

 

     
28282828| Finance Department, Government of Kerala 

    

        

 

 Here the user can prepare & Approve Proceedings against their G.O. After that they need to send the 

proceedings to Treasury by selecting the Treasury and entering the DDO Code. This DDO can bill this 

proceeding in ‘BIMS’ Application. Also some reports are there for the user’s needs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the Department, User Type and enter 

Mobile Number and PIN number in the 

respective boxes and click ‘Submit’. This will 

lead them to the proceeding generation 

window. 
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AS Entry – AS for PSTSB 

 Administrative Sanction for Plan Scheme TSB account entry is possible through this menu. The form 

will seen like this :  
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AS Entry – AS for PSTSB Edit 

Here the Administrative Department can edit/delete the prepared AS (for PSTSB) Details, before it’s 

approval. 

 

 

 

 

 

 

 

 

 

 

 

 

 



e-Ledger                                                                                                                                              User Manual                                                             

 

 

     
31313131| Finance Department, Government of Kerala 

    

        

AS Entry – AS for PSTSB Approval 

 Approve/Disapprove option for AS for PSTB available here. Approval makes the AS available for bill 

taking in ‘BIMS’ application (i.e., the DDO mentioned in AS can prepare the bill). Now the AS amount can 

be transferred to the mentioned PSTSB account. 
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AS Entry – AS for WORK 

 Administrative Sanction for WORK entry is possible through this menu. The only difference from the 

AS for PSTSB is it doesn’t capture the account details. The form will seen like this : 
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AS Entry – AS for WORK Edit 

 Here the Administrative Department can edit/delete the prepared AS (for WORK) Details, before it’s 

approval. 

AS Entry – AS for WORK Approval 

 Approve/Disapprove option for AS for WORK available here. Approval makes the AS available for 

bill preparation in ‘BIMS’ application (i.e., the DDO mentioned in AS can prepare the bill). 


